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1 Get Access

1.1 Try our workstations.

Setting up a LATEX distribution and LYX can be challenging. I expect that one-half of the students who try
fail to see this through.

The best way to decide if you might like to use LYX is to use somebody else’s computer. Then set up
your own computer later. You are free to visit CRMDA where we can let you log in and try one of our
workstations.

1.2 Install on your computer

On Windows, the most popular LATEX distributions are MikTEX and TEXLive. The “LYX Installer Bundle
for Windows” includes the MikTEX LATEX distribution and a spell-checker, along with LYX. That’s a good
place to start. Please be aware that the minimal MikTEX download will then require separate installation
of a whole bunch of packages.

On Macintosh, get the big MacTEX download, which has a convenient collection. It is a big download, about
250GB. LYX is available for Macintosh.

2 The Very First LYX Session

Lets assume you have found a computer on which a working copy of LYX is installed. Start LYX.

When you run LYX for the first time, it might “start” right away. But it might take 10 minutes or so to
“show up”. Don’t worry, the reason why that’s slow will be discussed below.

Once LYX starts, you should see a screen that looks like Figure 1.
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Figure 1: LYX Startup

You’ll never see that document again. It shows only to first time users.

2.1 Look at the Manuals

In the LYX graphical interface, look at the top right item, “Help”. The manuals are there for a reason. The
LYX team members have worked hard on them, so please look them over.

2.2 Save Your First LYX File

Why not save a fresh copy of that welcome file? In the menu, choose File, “Save As”, and let LYX know
where you want to save it. I saved that file in my home user account. I did not change the name, which is
“splash.lyx”.

When you work on that file, LYX will deduce that the directory in which the file was placed is the “current
working directory” of your work. Any output files will be placed into the same directory.

2.3 Compile your First LATEX Document

The “googly eyes” icon on the far left should launch a LATEX compiler. (There is a shortcut key,
Ctrl-R).

If all goes well, and you are on a system that defaults to PDF output, a PDF viewer should open and display
a compiled version of the document.
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On some systems, that first compile might be slow. It might take several minutes. And the PDF viewer,
if it is Adobe Reader, may be slow to open. We have never gotten a solid explanation for the phenomenon
that the Reader might open quickly for one user on a system, but slowly for another.

This “compilation” occurs in a temporary folder. A number of temporary files are generated. Most new
users never have to bother with it. In the Lyx configuration, one can customize the location where the
temporary files are created. It is sometimes instructive to dig into that. If you have to do that, it usually
means something has gone wrong.

In 2015, students in our lab started to notice that LYX warns the user that it was unable to delete the
temporary folder when it is closing down. We have not learned the cause of this behavior, but suspect it is
linked to some copies of Adobe Reader remaining open, but somehow hidden from the user.

2.4 Make a Minor Change, Compile Again

Let’s try a document level change. Lets spruce up the fonts.

The default LYX (and LATEX) setup uses fonts that are not optimized for inclusion in a PDF document. You
may notice the fonts in the PDF document are a bit rough, with jagged edges and uneven color. That can
be fixed by changing the fonts.

In the menu system, find the item “Document”. That is the main configuration area for this document.
Scroll down to the bottom of the menu, choose “Settings”. Hopefully, on the left side you see a section
“Fonts”. When you open that, you should see something like the snapshot in Figure 2.

As you can see, the fonts are changed which display Roman, Sans Serif, and Typewriter fonts to the Latin
Modern family. There are many other types of fonts that will work as well. If the Latin Modern family is
not available in your listing, it means the computer does not yet have the Latin Modern packages installed
in the LATEX. There are plenty of other good options. Some exploration might be worthwhile.

Compile Again = “Update” the document.

To Re-compile, you may save time if you use the “Update” button in the title bar. That’s right next to the
. On a Linux system, it looks like

The update approach only works if the PDF viewer is still open. This may be beneficial because a full
recompilation may re-do more work than necessary. A googly-eyed recompilation will cause a new PDF
viewer session to launch as well.

3 A Second LYX Session: Explore the Environments

3.1 Get started.

1. Create a new document.

Pull Down File -> New. That will create a blank canvas for you.

I can’t say for sure what type of document your LYX system has created for you. You can check. Click
Document -> Settings and see what the Document Class is.
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Figure 2: Font Change

In the newer versions of LYX, the Document Class menu has a very nice listing of all document types
that LYX might be able to generate, if you have all of the LATEX packages and support programs
installed. The document types that are listed as “Unavailable” are the ones for which LYX cannot find
the packages it needs. If you think you do have the packages, it may be LYX has not noticed yet.
Menu click Tools -> Reconfigure and re-start LYX.

2. Compile Early, Compile Often

Type some words, hit return. Try to compile the document (click the googly eyes, or Ctrl-R).

Be patient, it usually works. Users sometimes see trouble at this stage, when the PC is missing some
LATEX features.

Type some more stuff. You need to get used to re-compiling the document. Often! Especially as you
are a novice, you need to realize that you can type in stuff that won’t compile. Flaws are tough to
find, it is best to find them as soon as possible.

WARNING: People who ignore the “compile often” advice deserve what they get. Documents some-
times don’t compile. The error messages from LATEX are very difficult to understand. There is about
0% chance a novice can disentangle them.
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3.2 The Environment Chooser Thingie

At the top of the LYX GUI, most users see a row of pulldown menus, and then two rows of additional
“ribbon” style icons and one super-important pull down element: the Environment Chooser. It is in the
middle row, on the far left.

The Environment Chooser says I’m currently in a “Standard” environment. That’s from my Linux worksta-
tion, on MS Windows, that looks a bit different, like this:

The word “Standard” means “basic paragraph.”

3.3 Tour the Environments

Click on the chooser. Look things over, then try some.

3.3.1 Claim Ownership (Author Environment)

1. In a paragraph by itself, type your name. While the cursor is in that paragraph, look for the Environ-
ment Chooser. Hit the little triangle, select “Author”.
There should be a brief “spasm” because your name will show up in big, bold letters.

3.3.2 Insert Title (Title Environment)

In a paragraph by itself, type a title. In the Environment Chooser, choose “Title”. Notice what happens.

3.3.3 What day is it? (Date Environment)

1. You want the date, don’t you? In a paragraph by itself, you can type the date as you want it displayed.
Then use the Environment pull-down to choose “Date”. Compile NOW!

2. Tip: If you want your date to always be correct for today, this will work. Hit the button in the
menu bar, and inside the little box, type \today. That’s “backslash t-o-d-a-y”.

3.3.4 Numbered Structural Elements (Section Environments)

Most LATEX document types, but not all, allow users to specify section headings. In the default document
in LYX, which is an article, the Environment Chooser should list several levels of sections. As you will see,
the final appearance is determined by the document class. You DO NOT try to “make it bold” or “center
it” or do any finger painting. You choose the environment, the LATEX system decides how it will look.

1. Type a section heading.
2. Choose “Section” in the Environment Chooser. Note that makes a big, bold section. You can revise

your title. When finished, hit return. Note the Environment type returns to standard. Type some
stuff. Your environment should look like a standard paragraph. Hit Return.

3. Type a sub section heading. In the Environment pull-down, choose “Subsection”. Revise the subsection
heading however you like, hit return.

4. Type a sub sub heading. In the Environment pull-down, choose “Subsubsection.”

6



3.3.5 Unnumbered Structural Elements (Section* Environments)

Maybe you are not fond of numbered sections. That’s why most document types allow environments named
Section*, Subsection*, and Subsubsection*. They are just as big and bold as the others, but with no numbers.

3.3.6 Numbered list (Enumerated List Environment)

1. An enumerated list is a numbered list. LYX, as in other things, relies on the document type to decide
how the list ought to be displayed. Sometimes users feel “straight-jacketed” by the styling because it
is rather difficult to customize. It is best for new users to live with this the way it is.

2. Start typing any stuff you want. Maybe some Latin. Hit enter, type more.

3. Leave the cursor at the end of the last paragraph you entered. In the Environment chooser, pick
“Enumerate”. That should put a number at the front of your current paragraph.

4. Hit enter. New number, new paragraph. Note that, unlike the Section environment, you are not
dumped back into the standard environment. You are in a new numbered item. Type some stuff.

5. Do it again, for fun.

6. Then Compile!

7. Now let’s explore the “lists inside lists”.

a) Hit enter again, then it inserts a number. Hit the TAB key. type some more.

b) Hit enter type some more.

Are you getting the idea yet? You are in a nested list.

c) Hit enter again, then do Shift-TAB. That should move your enumeration back one level.

d) Type some more stuff.

e) You enter ordinary, standard paragraphs inside the numbered list elements. Under a numbered
element, type some stuff. Before you hit enter, choose “Standard” in the Environment chooser.
That seems to “throw you out of the numbered list.” Don’t despair yet. Hit the TAB key, and it
should move the Standard, unnumbered paragraph under the enumerated list.

f) Hit enter, type more stuff. Hit Return. Hopefully, the number re-starts.

There are a lot of funny things you can do with enumerated lists. I’m just scratching the surface
here, but this includes 95% of the stuff I do.

8. There are several different ways to adjust the “depth” of nesting.

a) In the LYX pulldown menu system, under Edit, there is a “Decrease Depth” element.

b) In the bottom ribbon at the top of the GUI, there is a pair of icons, . One can push
the current element deeper in the nesting (same as TAB), and one will pull the element back one
level (Same as Shift-TAB).

3.3.7 Make a Bullet list (Itemized List Environment)

A Bullet list is an un-numbered list. It is, otherwise, equivalent in usage to a numbered list.

• Type some words, then in the Environment Chooser, select Itemize. You should see a bullet list, like
the current line.

• Hit enter, you should be at the start of a new bullet list item.
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• As in enumerated lists, you can

1. include nested lists by hitting the TAB key (or by using the menu or ribbon shortcuts).

2. include standard paragraphs by typing in some material, using the Environment Chooser to change
it to standard, and then hitting TAB a few times.

3.3.8 Make a list of definitions (Description List Environment)

Type “Thing the word on the left” and then go to the Environment Chooser and select “Description”. That
should cause a bold faced presentation of your first word and the rest is indented suitably.

Thing the word on the left

The thing on the left is the item. As you see in the next two elements, it might be more than word. There
is some Ctrl-Space magic here.

Item a single word or Ctrl-shift separated words can be on the left side of the description.

Here’s a key term a description has a big bold faced phrase on the left and then a longer description on
the right. Note ordinary spaces will separate your terms on the left side. Use Ctrl-Space to hold them
together.

Like all “list” environments, a description environment will keep making more description items when you
hit enter.

3.3.9 A Code Listing is Launched Differently

One of my favorite LATEX environments cannot be launched through the Environment Chooser. This is a
much more powerful, customizable content type. In the pull-down menus, find Insert and choose “Program
Listing”.

That creates an empty box. You better type something in there, because the box may be difficult to find if
you don’t use it. You should see a box with a stark white background, like so:

This is using the LATEX package called listings and there are some super-powers that await the users of
listings: To see just a few, right click with the mouse. This is an extremely powerful, customizable context
in which to show code examples. I use the listing environment for all of my R presentations.

3.3.10 Alt+p, a Shortcut key work remembering

Most people who know me are aware of the fact that I don’t memorize all of the keystrokes for everything.
I don’t mind letting a menu help me choose.

The exception arises when a chore must be repeated hundreds of times per hour. I change environments all
the time. Using the Environment Chooser was convenient and fun for the first 100,000 changes, but after a
while, I wore out the mouse. And I found about a shortcut key combination. Try this.

In the middle of a standard paragraph, hit Alt and “p”, which the LYX documentation refers to as “Alt+p”.
At the bottom of the LYX window, a message should appear:

Alt+p options: 0 1 2 3 4 5 6 * A Shift+A Alt+A Ctrl+A Shift+B C Shift+C D Shift+D E F Shift+F
I L Shift+L N Q Shift+Q ...
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Lyx will wait for you to hit another letter. Try the letter “e”. That should cause your current environment
to become a member in an Enumerated List. I don’t remember all of these, but here are the ones I do
remember and use very often
Alt+p, then: Environment result

s standard
e enumerated
i itemized (bullet) list
d description

4 A Third Session: Explore Math

Many people are pushed toward LATEX because they want the nice looking formulas. I know that is why I
started.

There are two types of math, that which is displayed “inline” and that which is centered and displayed in
its own separate environment.

4.1 Write some in-line math.

1. In the middle of any LYX text enviroment, hit

Ctrl-m

and an itty-bitty blue box should appear. It should also cause a graphic math chooser thingie to pop
out of the bottom of the LYX window.

2. Maybe you make your life simple now by just choosing one or two symbols.

3. Or Type like me. I’m Hitting Ctrl-m now and I’ll type this–literally “\beta \times \alpha \times
X_i (and then one more space to exit the box)”. If you do that, you will see β × α×Xi. Note I don’t
type extra spaces in there (you’ll see why if you forget and hit a space key). Just hit the space key one
time to let LYX know a symbol is done. Note “_” means “here comes a subscript.” And “^” means
superscript.

4.2 Create a display equation

1. That’s a centered thing on a line by itself. I do that very often, I have memorized the keyboard
shortcut Ctrl-Shift-m. I suppose I could have written Ctrl-M to describe that. Beginners might use
the pulldown menu. Look for Insert -> Math.

2. Try typing inside the math box the following “\sum _i=0 ^N x_i” (and then another space to exit
the blue box)”

N∑
i=0

xi (1)

3. Number that equation.

If your system is on all defaults, that won’t insert an equation number or a label. One often wants
numbered equations; there are several ways go get that done in LYX. The easiest thing is to right click
in the equation box. Choose “Number this Line”.

4. Insert a label for that equation. This won’t print; it is just a reminder for the author. Right click in
the equation. I always do this at the right edge of the equation box (but I’m told that is not strictly
necessary). Choose “Equation label”. That’s some word you’ll remember this equation by. Please use
this label for your first equation: “eq:pj”. Do that, just for my ego.
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5. Create a Cross reference to your equation. Type some “blah blah blah” and then write “as you can see
in equation (“, and then stop, in the pull down Insert -> Cross Reference and a chooser should appear.
There should only be one thing to choose there, “eq:pj”, so choose that, and hit the OK button. Then
type “)” and go on with your blah blah. You should see something correct, like (1), referring to the
equation. Those will automatically re-number themselves as you add more content in your document.

6. Compile that to see for yourself.

7. How much of the math markup language does a person need to memorize? Only practice can be your
guide. Memorize shortcuts for things you do often.

Memorize enough shortcuts to get the things you do very often done quickly. Use the menus for things
you don’t do more often than once time per week.

LYX will try to teach you the correct LATEX markup for these symbols. Left click in the display math
equation, and notice the math graphical interface pops up. If you use the mouse to choose a symbol,
the code you could have typed will flash up at the very bottom of the LYX window.

5 A Fourth Session: Try a LYX Template

If you are on a Macintosh, I suggest you look away for a moment. Your standard install is lacking the
template files, so there’s not much for you to do right now.

Otherwise, keep going. If you are on Windows or Linux, it is workable to click File -> New From Template.
Choose one, see if it works. Many of them won’t work because your system does not have all of the required
packages.

On the CRMDA remote desktop systems, I asked the administrators to make sure you can try the templates
APA6 and beamer-conference-ornate-20min.lyx without too much trouble. The beamer template has the
best commentary and instructions of any template I’ve ever found.

In case you are your own system administrator, you can make using the templates a little easier for your
users. That is discussed in the LYX installation material below.

6 Let LYX teach you LATEX

Some people refuse to use LYX, they think it is concealing too many details. They want to write “raw LATEX”.

Interactively

Hit the View menu and find the option “View Source”. That takes up the bottom part of the screen.

On the right side in that display, you can choose either “current paragraph” or “complete source” or “body
only”. If you choose “complete source”, it shows you the LATEX markup that it would suggest for you, if you
were writing this in LATEX.

Upon Export

Choose File -> Export -> LATEX (pdflatex). That creates a file in the current working directory. It will have
the suffix “.tex”. Go read that.

When your LATEX using colleagues make fun of you, and say “using LYX is like riding a tricycle with training
wheels!” you will have the last laugh. They have to type out all of that markup manually.
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Why is this Especially Useful?

Sometimes I’ll make a careless mistake, possibly a cut and paste or a silly edit that results in a LYX document
that will not compile. The LATEX errors are very tough to understand, and it seems the LYX system’s help
at finding them is not enough for me. In a bad situation, I’ll export the document to LATEX format, and
then I’ll open it with TEXMaker. I usually find out what’s wrong in that way because TEXMaker is a little
bit better at deciphering the LATEX error log.

7 More Advanced Chores to Consider

7.1 Is a ’default file’ right? No! Create a Template For Yourself.

When we started with the first LYX document, it was necessary to change basic document fonts. It is usually
necessary also to change the document type, customize the page margins, fiddle with the character encoding,
and then put some customization into the document preamble. Users will fiddle quite a bit to make the
document “just right”.

When the next project begins, we can benefit from all of that work by using the original document as a
template.

In 2014, I went to the trouble of creating a new Template document I would suggest to students. Then I
wrote an essay describing every click, every bit. In case you want to use my template, or learn how to make
your own, please browse here:

http://pj.freefaculty.org/guides/Computing-HOWTO/LatexAndLyx/LyX-article-template

The template document itself is called “template-20150827.lyx” The document “making-template-20150827.pdf”
describes (lovingly) every little step.

7.2 Insert “Floating” Tables and Figures

Floats automatically re-number themselves and LATEX places them according to a publisher’s requirements.

7.3 Include a Bibliography File

The first LYX guide I wrote was about writing documents that have bibliographies. There is still a copy
available.

http://pj.freefaculty.org/guides/Computing-HOWTO/LatexAndLyx/LyX-Bibliography

7.4 Sweave Research Reports

In a LATEX file, and hence in a LYX file, one can embed R code. The R code is sent to R, results are generated,
and they can be assembled into the resulting document automatically. This is one lynch pin in the workflow
of reproducible research.

http://pj.freefaculty.org/guides/Computing-HOWTO/LatexAndLyx/LyX-sweave-tutorial
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8 Attachments: Installation and Configuration Details

8.1 Windows System Administration Tips

Make sure MikTEX and LYX work well together on Windows for all users, not just the administrator.

Problem: MikTEX defaults to a minimal install. LYX requires many additional MikTEX packages.

In the Start menu, under MikTEX, there are programs for the installation of packages. If somebody with
administrative privileges runs the package manager, they can review the list of installed packages and add
more of them. To have a workable LATEX install for LYX, it is necessary to have at least the ones we list in 8.2.
When the administrator installs packages, they are dropped into C:\Program Files\MikTEX\2.9\tex\latex.

When a non-administrator runs LYX, LYX can ask the MikTEX system for new packages. They are installed
in the individual user’s account, in the directory. The CRMDA has prepared a document to explain LATEX
package administration. Please check http://crmda.ku.edu/guides for “LATEX Configuration”

C:\Users\username\AppData\Roaming\MiKTEX\2.9\tex\latex

When a user runs LYX for the first time, we can monitor that directory to see what packages are installed.
We did that on 2015-04-11, and the packages listed in Section 8.2.

Problem: If 10 users run LYX, then there are 10 sets of MikTEX packages scattered about in the computer.
It is more efficient if the administrator installs lots of packages. Over time, the administrator might
notice which packages are installed for users (check the user’s AppData/Roaming folder) and drop
them into the MikTEX location under "Program Files".

Problem: If you copy packages into the system folders, it is necessary to have the LATEX distribution re-index
the packages (equivalent of running texhash or mktexslr in Unix). MikTEX has menus for this: Settings
(Admin). On the top right there is a button called "Refresh FNDB". FNDB = File Name Data Base.

While you are on the Settings (Admin) pane, please check for the default paper size. It may be set for the
European standard A4 and we wish it would be letter size in the USA.

Problem: Users need to tell LYX to re-scan the distribution when packages are added. That is done by
starting LYX and running Tools -> Reconfigure.

8.2 Starting from the Minimal MikTEX package selection, these packages are
downloaded at the request of LYX

Users sometimes think that LYX is “stalled” when they try to start it. Actually, it is waiting for MikTEX to
get files.

12



aastex
achemso
aguplus
algorithms
apa
apacite
arabi
arabtex
arydshln
ascii
base
bbding
beamer
bera
bezos
bibtopic
booktabs
braille
braket
breakurl
cancel
caption
ccfonts
changepage
cite
cjk
cleveref
cmbright
colortbl
covington
csquotes
ctex
cyrillic
dinbrief

dtk
eco
elsarticle
elsevier
endfloat
endnotes
enumitem
epsf
esint
eso-pic
europecv
extsizes
fancybox
fancyhdr
fancyvrb
feyn
filecontents
footmisc
fourier
framed
frletter
g-brief
greek-inputen
harvard
hyphenat
ieeetran
ifmtarg
ifsym
jurabib
kluwer
koma-script
l3kernel
l3packages
lastpage

preview
pst-grad
pst-node
refstyle
revtex4
rotating
lettre
lettrine
lineno
ltfonts
luxi
marginnote
marvosym
mciteplus
memoir
mhchem
microtype
moderncv
mongolian-babel
ms
mwcls
natbib
nomencl
paper
paralist
pdfpages
pgf
picinpar
placeins
polyglossia
powerdot
prettyref

rotfloat
sauerj
savesym
seminar
sidecap
simplecv
skak
soul
spie
splitindex
sttools
subfig
textcase
textgreek
tipa
titlesec
tufte-latex
tugboat
turkmen
txfonts
type1cm
ucs
ulem
undertilde
units
upquote
wasysym
wrapfig
xargs
xcolor
xifthen
zhmetrics
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8.3 LYX Reconfiguration at Startup

1 $ lyx
2 LyX : Creat ing d i r e c t o r y /home/paul john/ . lyx2 . 0 /
3 LyX : r e c o n f i g u r i n g user d i r e c t o r y
4

5 Running : python −t t "/usr/ share/ lyx2 . 0 / c o n f i g u r e . py " −−with−vers ion −s u f f i x =2.0
6 check ing for a Latex2e program . . .
7 +checking for " l a t e x " . . . yes
8 check ing for a DVI p o s t p r o c e s s i n g program . . .
9 +checking for " pp latex " . . . no

10 check ing for pLaTeX , the Japanese LaTeX . . .
11 +checking for " p la t ex " . . . no
12 check ing for a java i n t e r p r e t e r . . .
13 +checking for " java " . . . yes
14 check ing for a p e r l i n t e r p r e t e r . . .
15 +checking for " p e r l " . . . yes
16 check ing for a Tgi f v iewer and e d i t o r . . .
17 +checking for " t g i f " . . . no
18 check ing for a Tgi f v iewer and e d i t o r . . .
19 +checking for " t g i f " . . . no
20 check ing for a FIG viewer and e d i t o r . . .
21 +checking for " x f i g " . . . yes
22 +checking for " j f i g 3 −i t e x t . j a r " . . . no
23 +checking for " j f i g 3 . j a r " . . . no
24 check ing for a FIG viewer and e d i t o r . . .
25 +checking for " x f i g " . . . yes
26 +checking for " j f i g 3 −i t e x t . j a r " . . . no
27 +checking for " j f i g 3 . j a r " . . . no
28 check ing for a Dia viewer and e d i t o r . . .
29 +checking for " d ia " . . . yes
30 check ing for a Dia viewer and e d i t o r . . .
31 +checking for " d ia " . . . yes
32 check ing for a Grace viewer and e d i t o r . . .
33 +checking for " xmgrace " . . . no
34 check ing for a Grace viewer and e d i t o r . . .
35 +checking for " xmgrace " . . . no
36 check ing for a FEN viewer and e d i t o r . . .
37 +checking for " xboard " . . . no
38 check ing for a FEN viewer and e d i t o r . . .
39 +checking for " xboard " . . . no
40 check ing for a SVG viewer and e d i t o r . . .
41 +checking for " inkscape " . . . yes
42 check ing for a SVG viewer and e d i t o r . . .
43 +checking for " inkscape " . . . yes
44 check ing for a r a s t e r image viewer . . .
45 +checking for " xv " . . . no
46 +checking for " kview " . . . no
47 +checking for " gimp−remote " . . . no
48 +checking for " gimp " . . . yes
49 check ing for a r a s t e r image e d i t o r . . .
50 +checking for " gimp−remote " . . . no
51 +checking for " gimp " . . . yes
52 check ing for a text e d i t o r . . .
53 +checking for " xemacs " . . . no
54 +checking for " gvim " . . . yes
55 +checking for " k e d i t " . . . no
56 +checking for " kwr i te " . . . no
57 +checking for " kate " . . . no
58 +checking for " j e d i t " . . . no
59 +checking for " TeXnicCenter " . . . no
60 +checking for "WinEdt" . . . no
61 +checking for " WinShell " . . . no
62 +checking for "PSPad" . . . no
63 +checking for " ned i t " . . . no
64 +checking for " g e d i t " . . . yes
65 +checking for " notepad " . . . no
66 +checking for " geany " . . . no

14



67 +checking for " l e a f p a d " . . . no
68 +checking for " mousepad " . . . no
69 check ing for a text e d i t o r . . .
70 +checking for " xemacs " . . . no
71 +checking for " gvim " . . . yes
72 +checking for " k e d i t " . . . no
73 +checking for " kwr i te " . . . no
74 +checking for " kate " . . . no
75 +checking for " j e d i t " . . . no
76 +checking for " TeXnicCenter " . . . no
77 +checking for "WinEdt" . . . no
78 +checking for " WinShell " . . . no
79 +checking for "PSPad" . . . no
80 +checking for " ned i t " . . . no
81 +checking for " g e d i t " . . . yes
82 +checking for " notepad " . . . no
83 +checking for " geany " . . . no
84 +checking for " l e a f p a d " . . . no
85 +checking for " mousepad " . . . no
86 check ing for gnumeric spreadshee t so f tware . . .
87 +checking for " gnumeric " . . . no
88 check ing for an HTML prev iewer . . .
89 +checking for " f i r e f o x " . . . yes
90 +checking for " m o z i l l a " . . . no
91 +checking for " netscape " . . . no
92 check ing for a BibTeX e d i t o r . . .
93 +checking for " j a b r e f " . . . no
94 +checking for " JabRef " . . . no
95 +checking for " p y b l i o g r a p h i c " . . . yes
96 +checking for " bibdesk " . . . no
97 +checking for " gbib " . . . no
98 +checking for " kbib " . . . no
99 +checking for " kbibtex " . . . no

100 +checking for " s ixpack " . . . no
101 +checking for " b i b e d i t " . . . no
102 +checking for " tkbibtexxemacs " . . . no
103 +checking for " gvim " . . . yes
104 +checking for " k e d i t " . . . no
105 +checking for " kwr i te " . . . no
106 +checking for " kate " . . . no
107 +checking for " ned i t " . . . no
108 +checking for " g e d i t " . . . yes
109 +checking for " notepad " . . . no
110 +checking for " geany " . . . no
111 +checking for " l e a f p a d " . . . no
112 +checking for " mousepad " . . . no
113 check ing for a P o s t s c r i p t prev iewer . . .
114 +checking for " kghostview " . . . no
115 +checking for " oku lar " . . . yes
116 +checking for " ev ince " . . . yes
117 +checking for " gv " . . . yes
118 +checking for " ghostview " . . . no
119 check ing for a PDF prev iewer . . .
120 +checking for " pdfview " . . . no
121 +checking for " kpdf " . . . no
122 +checking for " oku lar " . . . yes
123 +checking for " ev ince " . . . yes
124 +checking for " kghostview " . . . no
125 +checking for " xpdf " . . . yes
126 +checking for " acrobat " . . . no
127 +checking for " acroread " . . . yes
128 +checking for " gv " . . . yes
129 +checking for " ghostview " . . . no
130 check ing for a DVI prev iewer . . .
131 +checking for " xdvi " . . . yes
132 +checking for " kdvi " . . . no
133 +checking for " oku lar " . . . yes
134 +checking for " yap " . . . no
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135 +checking for " dviout " . . . no
136 check ing for an HTML prev iewer . . .
137 +checking for " f i r e f o x " . . . yes
138 +checking for " m o z i l l a " . . . no
139 +checking for " netscape " . . . no
140 check ing for Noteedit . . .
141 +checking for " n o t e e d i t " . . . no
142 check ing for Noteedit . . .
143 +checking for " n o t e e d i t " . . . no
144 check ing for an OpenDocument/OpenOffice v iewer . . .
145 +checking for " l i b r e o f f i c e " . . . yes
146 +checking for " l w r i t e r " . . . no
147 +checking for " l o w r i t e r " . . . yes
148 +checking for " oo wr i t e r " . . . no
149 +checking for " s w r i t e r " . . . no
150 +checking for " abiword " . . . yes
151 check ing for an OpenDocument/OpenOffice v iewer . . .
152 +checking for " l i b r e o f f i c e " . . . yes
153 +checking for " l w r i t e r " . . . no
154 +checking for " l o w r i t e r " . . . yes
155 +checking for " oo wr i t e r " . . . no
156 +checking for " s w r i t e r " . . . no
157 +checking for " abiword " . . . yes
158 check ing for a Rich Text and Word viewer . . .
159 +checking for " l i b r e o f f i c e " . . . yes
160 +checking for " l w r i t e r " . . . no
161 +checking for " l o w r i t e r " . . . yes
162 +checking for " oo wr i t e r " . . . no
163 +checking for " s w r i t e r " . . . no
164 +checking for " abiword " . . . yes
165 check ing for a Rich Text and Word viewer . . .
166 +checking for " l i b r e o f f i c e " . . . yes
167 +checking for " l w r i t e r " . . . no
168 +checking for " l o w r i t e r " . . . yes
169 +checking for " oo wr i t e r " . . . no
170 +checking for " s w r i t e r " . . . no
171 +checking for " abiword " . . . yes
172 check ing for the p d f l a t e x program . . .
173 +checking for " p d f l a t e x " . . . yes
174 check ing for XeTeX . . .
175 +checking for " x e l a t e x " . . . yes
176 check ing for LuaTeX . . .
177 +checking for " l u a l a t e x " . . . yes
178 check ing for LuaTeX (DVI) . . .
179 +checking for " d v i l u a l a t e x " . . . yes
180 check ing i f LuaTeX i s usab le . . . yes
181 check ing for a LaTeX/Noweb −> LyX conver t e r . . .
182 +checking for " tex2 lyx2 . 0 " . . . yes
183 check ing for a Noweb −> LaTeX conver t e r . . .
184 +checking for " noweave " . . . no
185 check ing for a Sweave −> LaTeX conver t e r . . .
186 +checking for " Rscr ip t " . . . yes
187 check ing for a k n i t r −> LaTeX conver t e r . . .
188 +checking for " Rscr ip t " . . . yes
189 check ing for a Sweave −> R/S code conve r t e r . . .
190 +checking for " Rscr ip t " . . . yes
191 check ing for a k n i t r −> R/S code conve r t e r . . .
192 +checking for " Rscr ip t " . . . yes
193 check ing for an HTML −> LaTeX conver t e r . . .
194 +checking for " html2 latex " . . . no
195 +checking for " gnuhtml2latex " . . . no
196 +checking for " html to la tex " . . . no
197 +checking for " html to la tex . j a r " . . . no
198 check ing for an MS Word −> LaTeX conver t e r . . .
199 +checking for " wvCleanLatex " . . . no
200 check ing for a LyX −> HTML conver t e r . . .
201 +checking for " e l y x e r . py " . . . no
202 +checking for " e l y x e r " . . . yes
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203 check ing for a LyX −> HTML (MS Word) conve r t e r . . .
204 +checking for " e l y x e r . py " . . . no
205 +checking for " e l y x e r " . . . yes
206 check ing for " l y x b l o g g e r module " . . . no
207 check ing for an OpenOffice . org −> LaTeX conver t e r . . .
208 +checking for " w2l " . . . no
209 check ing for an OpenDocument −> LaTeX conver t e r . . .
210 +checking for " w2l " . . . no
211 check ing for a LaTeX −> Open Document conve r t e r . . .
212 +checking for " o o l a t e x " . . . no
213 +checking for " mk4ht " . . . no
214 +checking for " o o l a t e x . sh " . . . no
215 +checking for "/usr/ share/ tex4ht/ o o l a t e x " . . . no
216 +checking for " h t l a t e x " . . . no
217 check ing for a LaTeX −> RTF conver t e r . . .
218 +checking for " l a t e x 2 r t f " . . . no
219 +checking for " l a t e x 2 r t " . . . no
220 check ing for a RTF −> HTML conver t e r . . .
221 +checking for " u n r t f " . . . no
222 check ing for a PS to PDF conver t e r . . .
223 +checking for " ps2pdf13 " . . . yes
224 check ing for a PS to TXT conver t e r . . .
225 +checking for " p s t o t e x t " . . . no
226 check ing for a PS to TXT conver t e r . . .
227 +checking for " p s 2 a s c i i " . . . yes
228 check ing for a PS to EPS conve r t e r . . .
229 +checking for " ps2eps " . . . yes
230 check ing for a PDF to PS conve r t e r . . .
231 +checking for " pdf2ps " . . . yes
232 check ing for a PDF to EPS conve r t e r . . .
233 +checking for " pdftops " . . . yes
234 check ing for a Beamer i n f o e x t r a c t o r . . .
235 +checking for " makebeamerinfo " . . . no
236 check ing for a DVI to TXT conver t e r . . .
237 +checking for " ca tdv i " . . . no
238 check ing for a DVI to PS conve r t e r . . .
239 +checking for " dvips " . . . yes
240 check ing for a DVI to PDF conver t e r . . .
241 +checking for " dvipdfmx " . . . yes
242 check ing for dvipng . . .
243 +checking for " dvipng " . . . yes
244 check ing for DVI to DTL conver t e r . . .
245 +checking for " dv2dt " . . . yes
246 check ing for a fax program . . .
247 +checking for " kdepr in t f ax " . . . no
248 +checking for " ksendfax " . . . no
249 +checking for " hylapex " . . . no
250 check ing for a FIG −> Image conve r t e r . . .
251 +checking for " f i g 2 d e v " . . . yes
252 check ing for a TIFF −> PS conver t e r . . .
253 +checking for " t i f f 2 p s " . . . yes
254 check ing for a TGIF −> EPS/PPM conver t e r . . .
255 +checking for " t g i f " . . . no
256 check ing for a WMF −> EPS conve r t e r . . .
257 +checking for " m e t a f i l e 2 e p s " . . . no
258 +checking for " wmf2eps " . . . yes
259 check ing for an EMF −> EPS conve r t e r . . .
260 +checking for " m e t a f i l e 2 e p s " . . . no
261 +checking for " wmf2eps " . . . yes
262 check ing for an EPS −> PDF conver t e r . . .
263 +checking for " epstopdf " . . . yes
264 check ing for an EPS −> PNG conver t e r . . .
265 +checking for " convert " . . . yes
266 check ing for a Grace −> Image conve r t e r . . .
267 +checking for " gracebat " . . . no
268 check ing for a Dot −> Image conve r t e r . . .
269 +checking for " dot " . . . no
270 check ing for a Dia −> PNG conver t e r . . .
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271 +checking for " d ia " . . . yes
272 check ing for a Dia −> EPS conve r t e r . . .
273 +checking for " d ia " . . . yes
274 check ing for a SVG −> PDF conver t e r . . .
275 +checking for " rsvg−convert " . . . no
276 +checking for " inkscape " . . . yes
277 check ing for a SVG −> EPS conve r t e r . . .
278 +checking for " rsvg−convert " . . . no
279 +checking for " inkscape " . . . yes
280 check ing for a SVG −> PNG conver t e r . . .
281 +checking for " rsvg−convert " . . . no
282 +checking for " inkscape " . . . yes
283 check ing for a spreadshee t −> l a t e x conve r t e r . . .
284 +checking for " s s c o n v e r t " . . . no
285 check ing for a LilyPond −> EPS/PDF/PNG conver t e r . . .
286 +checking for " l i l y p o n d " . . . no
287 check ing for a LilyPond book (LaTeX) −> LaTeX conver t e r . . .
288 +checking for " l i l ypond −book " . . . no
289 check ing for a Noteedit −> LilyPond conve r t e r . . .
290 +checking for " n o t e e d i t " . . . no
291 check ing for SGML−t o o l s 2 . x ( DocBook ) , db2x s c r i p t s or x s l t p r o c . . .
292 +checking for " s g m l t o o l s " . . . no
293 +checking for " db2dvi " . . . no
294 +checking for " x s l t p r o c " . . . yes
295 Checking whether TeX a l l o w s spaces in f i l e names . . . yes
296 check ing for ChkTeX . . .
297 +checking for " chktex " . . . yes
298 check ing for BibTeX or a l t e r n a t i v e programs . . .
299 +checking for " b ibtex " . . . yes
300 +checking for " b ibtex8 " . . . yes
301 +checking for " b ibe r " . . . no
302 check ing for a s p e c i f i c Japanese BibTeX v a r i a n t . . .
303 +checking for " pbibtex " . . . yes
304 check ing for a v a i l a b l e index p r o c e s s o r s . . .
305 +checking for " tex indy " . . . no
306 +checking for " makeindex " . . . yes
307 +checking for " xindy " . . . no
308 check ing for an index p r o c e s s o r appropr ia te to Japanese . . .
309 +checking for " mendex " . . . yes
310 check ing for the s p l i t i n d e x p r o c e s s o r . . .
311 +checking for " s p l i t i n d e x . p l " . . . no
312 +checking for " s p l i t i n d e x " . . . yes
313 check ing for a nomenclature p r o c e s s o r . . .
314 +checking for " makeindex " . . . yes
315 check ing for a spoo l command . . .
316 +checking for " lp " . . . yes
317 +checking l i s t o f modules . . .
318 /usr/ share/ lyx2 . 0 / l ay out s /noweb . module
319 /usr/ share/ lyx2 . 0 / l ay out s / m i n i m a l i s t i c . module
320 /usr/ share/ lyx2 . 0 / l ay out s / i n i t i a l s . module
321 /usr/ share/ lyx2 . 0 / l ay out s /fix−cm. module
322 /usr/ share/ lyx2 . 0 / l ay out s /enumitem . module
323 /usr/ share/ lyx2 . 0 / l ay out s /theorems−chap . module
324 /usr/ share/ lyx2 . 0 / l ay out s / k n i t r . module
325 /usr/ share/ lyx2 . 0 / l ay out s / l i l y p o n d . module
326 /usr/ share/ lyx2 . 0 / l ay out s /theorems−chap−bytype . module
327 /usr/ share/ lyx2 . 0 / l ay out s / log ica lmkup . module
328 /usr/ share/ lyx2 . 0 / l ay out s /theorems−ams−extended . module
329 /usr/ share/ lyx2 . 0 / l ay out s /theorems−sec−bytype . module
330 /usr/ share/ lyx2 . 0 / l ay out s /theorems−ams . module
331 /usr/ share/ lyx2 . 0 / l ay out s /endnotes . module
332 /usr/ share/ lyx2 . 0 / l ay out s / l i n g u i s t i c s . module
333 /usr/ share/ lyx2 . 0 / l ay out s / f i x l t x 2 e . module
334 /usr/ share/ lyx2 . 0 / l ay out s /theorems−ams−extended−bytype . module
335 /usr/ share/ lyx2 . 0 / l ay out s /customHeadersFooters . module
336 /usr/ share/ lyx2 . 0 / l ay out s / f oo t toend . module
337 /usr/ share/ lyx2 . 0 / l ay out s /tabs−within−s e c t i o n s . module
338 /usr/ share/ lyx2 . 0 / l ay out s /theorems−ams−bytype . module
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339 /usr/ share/ lyx2 . 0 / l ay out s /theorems−named . module
340 /usr/ share/ lyx2 . 0 / l ay out s /theorems−s ec . module
341 /usr/ share/ lyx2 . 0 / l ay out s / b r a i l l e . module
342 /usr/ share/ lyx2 . 0 / l ay out s /hanging . module
343 /usr/ share/ lyx2 . 0 / l ay out s /natbibapa . module
344 /usr/ share/ lyx2 . 0 / l ay out s /sweave . module
345 /usr/ share/ lyx2 . 0 / l ay out s /eqs−within−s e c t i o n s . module
346 /usr/ share/ lyx2 . 0 / l ay out s /theorems−std . module
347 /usr/ share/ lyx2 . 0 / l ay out s /theorems−s t a r r e d . module
348 /usr/ share/ lyx2 . 0 / l ay out s /theorems−bytype . module
349 /usr/ share/ lyx2 . 0 / l ay out s / f i g s −within−s e c t i o n s . module
350 done
351 check ing LaTeX c o n f i g u r a t i o n . . . default va lue s
352 +checking l i s t o f t e x t c l a s s e s . . .
353 done
354 check ing LaTeX c o n f i g u r a t i o n . . . auto
355 +I n s p e c t i n g your LaTeX c o n f i g u r a t i o n .
356 +checking for LaTeX v e r s i o n . . . 2014/05/01
357 +checking for a v a i l a b l e hyphenation pat t e rn s . . .
358 +checking for default encoding ( t h i s may take a long time )
359 + checking for ec f o n t s . . . yes
360 + checking for ec support in LaTeX format . . . yes
361 + default encoding w i l l be set to T1
362 +checking for package accent s [ accent s ] . . . yes
363 +checking for package a lgor i thm [ a lgor i thm ] . . . yes
364 +checking for package amstext [ amstext ] . . . yes
365 +checking for package arab i [ a r a b i c . l d f ] . . . no
366 +checking for package array [ array ] . . . yes
367 +checking for package babel [ babel ] . . . yes
368 +checking for package b i b t o p i c [ b i b t o p i c ] . . . yes
369 +checking for package bm [bm ] . . . yes
370 +checking for package booktabs [ booktabs ] . . . yes
371 +checking for package b r a i l l e [ b r a i l l e ] . . . yes
372 +checking for package breakur l [ b r eakur l ] . . . yes
373 +checking for package CJKutf8 [ CJKutf8 ] . . . no
374 +checking for package c a l c [ c a l c ] . . . yes
375 +checking for package c o l o r [ c o l o r ] . . . yes
376 +checking for package covington [ covington ] . . . no
377 +checking for package c squote s [ c squote s ] . . . yes
378 +checking for package c y r i l l i c [ koi8−r . de f ] . . . no
379 +checking for package dv ipos t [ dv ipost ] . . . no
380 +checking for package endnotes [ endnotes ] . . . yes
381 +checking for package enumitem [ enumitem ] . . . yes
382 +checking for package e s i n t [ e s i n t ] . . . yes
383 +checking for package eso−p i c [ eso−p i c ] . . . yes
384 +checking for package f o n t s p e c [ f o n t s p e c ] . . . yes
385 +checking for package h h l i n e [ h h l i n e ] . . . yes
386 +checking for package i f t h e n [ i f t h e n ] . . . yes
387 +checking for package greek−inputenc [ i so −8859−7. de f ] . . . no
388 +checking for package fancybox [ fancybox ] . . . yes
389 +checking for package fancyhdr [ fancyhdr ] . . . yes
390 +checking for package f i x l t x 2 e [ f i x l t x 2 e ] . . . yes
391 +checking for package fix−cm [ f ix−cm ] . . . yes
392 +checking for package f l o a t [ f l o a t ] . . . yes
393 +checking for package framed [ framed ] . . . yes
394 +checking for package geometry [ geometry ] . . . yes
395 +checking for package graphicx [ graphicx ] . . . yes
396 +checking for package hyp er r e f [ h ype r r e f ] . . . yes
397 +checking for package hyphenat [ hyphenat ] . . . yes
398 +checking for package j apanese [ japanese . l d f ] . . . no
399 +checking for package j u ra b i b [ j u r a b i b ] . . . yes
400 +checking for package l a t e x 8 [ l a t e x 8 ] . . . no
401 +checking for package l e t t r i n e [ l e t t r i n e ] . . . yes
402 +checking for package l i s t i n g s [ l i s t i n g s ] . . . yes
403 +checking for package l i t h u a n i a n [ l i t h u a n i a n . l d f ] . . . no
404 +checking for package l o n g t a b l e [ l o n g t a b l e ] . . . yes
405 +checking for package lua inputenc [ lua inputenc ] . . . yes
406 +checking for package mathdots [ mathdots ] . . . yes
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407 +checking for package mathrs f s [ mathrs f s ] . . . yes
408 +checking for package mhchem [ mhchem ] . . . yes
409 +checking for package mongolian [ mongolian . l d f ] . . . no
410 +checking for package multirow [ multirow ] . . . yes
411 +checking for package natbib [ natbib ] . . . yes
412 +checking for package n i c e f r a c [ n i c e f r a c ] . . . yes
413 +checking for package nomencl [ nomencl ] . . . yes
414 +checking for package pdfcolmk [ pdfcolmk ] . . . yes
415 +checking for package p o l y g l o s s i a [ p o l y g l o s s i a ] . . . yes
416 +checking for package pdfpages [ pdfpages ] . . . yes
417 +checking for package p r e t t y r e f [ p r e t t y r e f ] . . . yes
418 +checking for package preview [ preview ] . . . yes
419 +checking for package r e f s t y l e [ r e f s t y l e ] . . . yes
420 +checking for package r o t a t i n g [ r o t a t i n g ] . . . yes
421 +checking for package r o t f l o a t [ r o t f l o a t ] . . . yes
422 +checking for package s e r b i a n c [ s e r b i a n c . l d f ] . . . no
423 +checking for package s e t s p a c e [ s e t s p a c e ] . . . yes
424 +checking for package s l a s h e d [ s l a s h e d ] . . . yes
425 +checking for package s o u l [ s o u l ] . . . yes
426 +checking for package s p l i t i d x [ s p l i t i d x ] . . . yes
427 +checking for package s u b f i g [ s u b f i g ] . . . yes
428 +checking for package s u b s c r i p t [ s u b s c r i p t ] . . . yes
429 +checking for package Sweave [ Sweave ] . . . yes
430 +checking for package textcomp [ textcomp ] . . . yes
431 +checking for package thswitch [ thswitch ] . . . no
432 +checking for package turkmen [ turkmen . l d f ] . . . no
433 +checking for package ulem [ ulem ] . . . yes
434 +checking for package u n d e r t i l d e [ u n d e r t i l d e ] . . . no
435 +checking for package u n i t s [ u n i t s ] . . . yes
436 +checking for package url [ url ] . . . yes
437 +checking for package v a r i o r e f [ v a r i o r e f ] . . . yes
438 +checking for package wasy [ wasy ] . . . no
439 +checking for package wrapf ig [ wrapf ig ] . . . yes
440 +checking for package xargs [ xargs ] . . . yes
441 +checking for package x c o l o r [ x c o l o r ] . . . yes
442 +checking for package xkeyval [ xkeyval ] . . . yes
443 +checking for package arydshln [ arydshln ] . . . no
444 +checking for package braket [ braket ] . . . yes
445 +checking for package c a n c e l [ c a n c e l ] . . . yes
446 +checking for package capt ion [ capt ion ] . . . yes
447 +checking for package c o l o r t b l [ c o l o r t b l ] . . . yes
448 +checking for package diagbox [ diagbox ] . . . yes
449 +checking for package etoo lbox [ e too lbox ] . . . yes
450 +checking for package eurosym [ eurosym ] . . . yes
451 +checking for package fp [ fp ] . . . yes
452 +checking for package marginnote [ marginnote ] . . . yes
453 +checking for package p i c i n p a r [ p i c i n p a r ] . . . yes
454 +checking for package p i c t 2 e [ p i c t 2 e ] . . . yes
455 +checking for package s idecap [ s idecap ] . . . yes
456 +checking for package upgreek [ upgreek ] . . . yes
457 +checking for package p s n f s s [ t imes . s ty ] . . . yes
458 +checking for package avant [ avant ] . . . yes
459 +checking for package bookman [ bookman ] . . . yes
460 +checking for package chancery [ chancery ] . . . yes
461 +checking for package c h a r t e r [ c h a r t e r ] . . . yes
462 +checking for package c o u r i e r [ c o u r i e r ] . . . yes
463 +checking for package h e l v e t [ h e l v e t ] . . . yes
464 +checking for package mathpazo [ mathpazo ] . . . yes
465 +checking for package mathpple [ mathpple ] . . . yes
466 +checking for package mathptm [ mathptm ] . . . yes
467 +checking for package mathptmx [ mathptmx ] . . . yes
468 +checking for package newcent [ newcent ] . . . yes
469 +checking for package p i f o n t [ p i f o n t ] . . . yes
470 +checking for package utopia [ utopia ] . . . yes
471 +checking for package ae [ ae ] . . . yes
472 +checking for package bera [ bera ] . . . yes
473 +checking for package c c f o n t s [ c c f o n t s ] . . . yes
474 +checking for package cmbright [ cmbright ] . . . yes
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475 +checking for package eco [ eco ] . . . yes
476 +checking for package f eyn [ feyn ] . . . yes
477 +checking for package f o u r i e r [ f o u r i e r ] . . . yes
478 +checking for package lmodern [ lmodern ] . . . yes
479 +checking for package luximono [ luximono ] . . . no
480 +checking for package symbol [ uusy . fd ] . . . yes
481 +checking for package t i p a [ t i p a ] . . . yes
482 +checking for package t ipx [ t ipx ] . . . yes
483 +checking for package tone [ tone ] . . . yes
484 +checking for package zhmetr i c s [ c 7 0 f s . fd ] . . . no
485 +checking for package a s c i i [ a s c i i ] . . . yes
486 +checking for package bbding [ bbding ] . . . yes
487 +checking for package i f sym [ i f sym ] . . . yes
488 +checking for package marvosym [ marvosym ] . . . yes
489 +checking for package pmboxdraw [ pmboxdraw ] . . . yes
490 +checking for package t e x t g r e e k [ t e x t g r e e k ] . . . yes
491 +checking for package t x f o n t s [ t x f o n t s ] . . . yes
492 +checking for package wasysym [ wasysym ] . . . yes
493 +checking for document class AEA [AEA, amsmath . sty , harvard . sty , m u l t i c o l . sty , s e t s
494 +checking for document class IEEEtran [ IEEEtran ] . . . yes
495 +checking for document class aapaper [ aa ] . . . no
496 +checking for document class aastex [ aastex , amssymb . sty , latexsym . sty , natbib . s ty
497 +checking for document class aa [ aa , answers . s ty ] . . . no
498 +checking for document class achemso [ achemso , capt ion . sty , c o u r i e r . sty , c l e v e r e f .
499 +checking for document class acmsiggraph [ acmsiggraph , l i n e n o . s ty ] . . . no
500 +checking for docbook class agu−dtd . . . yes
501 +checking for document class agums [ aguplus , agums . s ty ] . . . no
502 +checking for document class agutex [ agutex ] . . . no
503 +checking for document class amsart [ amsart ] . . . yes
504 +checking for document class amsbook [ amsbook ] . . . yes
505 +checking for document class apa6 [ apa6 , a p a c i t e . sty , e n d f l o a t . sty , endnotes . sty , f
506 +checking for document class apa [ apa , a p a c i t e . sty , e n d f l o a t . sty , endnotes . sty , f l u
507 +checking for document class arab−a r t i c l e [ arabart , arabrep , a l t x e x t . sty , arabext .
508 +checking for document class armenian−a r t i c l e [ a r t i c l e ] . . . yes
509 +checking for document class a r t i c l e −beamer [ a r t i c l e , b e a m e r a r t i c l e . sty , keyval . s
510 +checking for document class a r t i c l e [ a r t i c l e ] . . . yes
511 +checking for document class beamer [ beamer , amssymb . sty , h ype r r e f . sty , pgf . sty , xc
512 +checking for document class book [ book ] . . . yes
513 +checking for document class broadway [ broadway , extramarks . sty , fancyhdr . sty , l a s
514 +checking for document class ches s [ a r t i c l e , c a l c . sty , lambda . sty , lyxskak . sty , pst
515 +checking for document class c l2emult [ c l2emult , m u l t i c o l . s ty ] . . . no
516 +checking for document class ctex−a r t i c l e [ c texart , savesym . sty , xeCJK . sty ] . . .
517 +checking for document class ctex−book [ ctexbook , savesym . sty , xeCJK . sty ] . . . no
518 +checking for document class ctex−report [ ctexrep , savesym . sty , xeCJK . sty ] . . .
519 +checking for document class d i n b r i e f [ d i n b r i e f ] . . . yes
520 +checking for docbook class docbook−book . . . yes
521 +checking for docbook class docbook−chapter . . . yes
522 +checking for docbook class docbook−s e c t i o n . . . yes
523 +checking for docbook class docbook . . . yes
524 +checking for document class doubleco l −new [ doubleco l −new, amsmath . sty , amssymb . s
525 +checking for document class dtk [ dtk , d tk logos . sty , f i l e c o n t e n t s . sty , m u l t i c o l . s t
526 +checking for document class e c t a a r t [ e c t a a r t ] . . . no
527 +checking for document class egs [ egs ] . . . no
528 +checking for document class e l s a r t i c l e [ e l s a r t i c l e , natbib . sty , p i f o n t . s ty ] . . .
529 +checking for document class e l s a r t [ e l s a r t , amssymb . sty , latexsym . sty ] . . . no
530 +checking for document class entc s [ entcs , amssymb . sty , entcsmacro . sty , h ype r r e f . s
531 +checking for document class europecv [ europecv , fancyhdr . sty , l o n g t a b l e . sty , ucs .
532 +checking for document class e x t a r t i c l e [ e x t a r t i c l e ] . . . yes
533 +checking for document class extbook [ extbook ] . . . yes
534 +checking for document class e x t l e t t e r [ e x t l e t t e r ] . . . yes
535 +checking for document class e x t r e p o r t [ e x t r e p o r t ] . . . yes
536 +checking for document class f o i l s [ f o i l s ] . . . no
537 +checking for document class f r l e t t e r [ f r l e t t e r ] . . . no
538 +checking for document class g−b r i e f 2 [ g−b r i e f 2 ] . . . yes
539 +checking for document class g−b r i e f [ g−b r i e f ] . . . yes
540 +checking for document class heb−a r t i c l e [ a r t i c l e , theorem . s ty ] . . . yes
541 +checking for document class heb− l e t t e r [ l e t t e r ] . . . yes
542 +checking for document class hollywood [ hollywood , c a l c . sty , fancyhdr . sty , ulem . s t
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543 +checking for document class i jmpc [ ws−ijmpc , amsmath . sty , amssymb . sty , r o t a t i n g . s
544 +checking for document class ijmpd [ ws−ijmpd , amsmath . sty , amssymb . sty , r o t a t i n g . s
545 +checking for document class i o p a r t [ i opart , amsmath . sty , amssymb . sty , iopams . sty ,
546 +checking for document class i s p r s [ i s p r s , e p s f i g . sty , t imes . s ty ] . . . no
547 +checking for document class j a r t i c l e [ j a r t i c l e ] . . . no
548 +checking for document class j a s a t e x [ j a s a t e x ] . . . no
549 +checking for document class jbook [ jbook ] . . . no
550 +checking for document class j g r g a [ aguplus , j g r g a . s ty ] . . . no
551 +checking for document class j r e p o r t [ j r e p o r t ] . . . no
552 +checking for document class j s a r t i c l e [ j s a r t i c l e ] . . . no
553 +checking for document class j sbook [ j sbook ] . . . no
554 +checking for document class j s s [ j s s , ae . sty , c o l o r . sty , fancyvrb . sty , hyp e r r e f . s t
555 +checking for document class kluwer [ kluwer ] . . . yes
556 +checking for document class l a t e x 8 [ a r t i c l e , l a t e x 8 . sty , t imes . s ty ] . . . no
557 +checking for document class l e t t e r [ l e t t e r ] . . . yes
558 +checking for document class l e t t r e [ l e t t r e ] . . . yes
559 +checking for document class l i t e r a t e −a r t i c l e [ a r t i c l e , noweb . s ty ] . . . no
560 +checking for document class l i t e r a t e −book [ book , noweb . s ty ] . . . no
561 +checking for document class l i t e r a t e −report [ report , noweb . s ty ] . . . no
562 +checking for document class l l n c s [ l l n c s , a l i a s c n t . sty , m u l t i c o l . s ty ] . . . no
563 +checking for document class l tugboat [ l tugboat ] . . . yes
564 +checking for document class memoir [ memoir ] . . . yes
565 +checking for document class moderncv [ moderncv , c o l o r . sty , fancyhdr . sty , hyp e r r e f
566 +checking for document class mwart [ mwart ] . . . no
567 +checking for document class mwbk [mwbk ] . . . no
568 +checking for document class mwrep [ mwrep ] . . . no
569 +checking for document class paper [ paper ] . . . yes
570 +checking for document class powerdot [ powerdot , enumitem . sty , hype r r e f . sty , p s t r i
571 +checking for document class rec ipebook [ scrbook ] . . . yes
572 +checking for document class report [ report ] . . . yes
573 +checking for document class revtex4 [ revtex4 , natbib . sty , revsymb . s ty ] . . . yes
574 +checking for document class r evtex [ revtex , r evtex . s ty ] . . . no
575 +checking for document class s c r a r t c l [ s c r a r t c l ] . . . yes
576 +checking for document class s c r a r t i c l e −beamer [ s c r a r t c l , b e a m e r a r t i c l e . sty , keyv
577 +checking for document class scrbook [ scrbook ] . . . yes
578 +checking for document class s c r l e t t r [ s c r l e t t r ] . . . no
579 +checking for document class s c r l t t r 2 [ s c r l t t r 2 ] . . . yes
580 +checking for document class s c r r e p r t [ s c r r e p r t ] . . . yes
581 +checking for document class seminar [ seminar , sem−page . s ty ] . . . yes
582 +checking for document class s i aml tex [ s i aml tex ] . . . no
583 +checking for document class s i g p l a n c o n f [ s i g p l a n c o n f , natbib . s ty ] . . . no
584 +checking for document class s implecv [ s implecv ] . . . yes
585 +checking for document class s i n g l e c o l −new [ s i n g l e c o l −new, amsmath . sty , amssymb . s
586 +checking for document class s i n g l e c o l [ s i n g l e c o l , natbib . s ty ] . . . no
587 +checking for document class s l i d e s [ s l i d e s ] . . . yes
588 +checking for document class s p i e [ sp ie , c i t e . s ty ] . . . yes
589 +checking for document class s v g l o b a l 3 [ sv jour3 , svg lov3 . c lo , natbib . s ty ] . . . no
590 +checking for document class s v g l o b a l [ sv jour , s v g l o b a l . c l o ] . . . no
591 +checking for document class sv jog [ sv jour , sv jog . c lo , natbib . s ty ] . . . no
592 +checking for document class svmono [ svmono , foo tmi sc . sty , m u l t i c o l . sty , natbib . s t
593 +checking for document class svmult [ svmult , natbib . s ty ] . . . no
594 +checking for document class svprobth [ sv jour , svprobth . c l o ] . . . no
595 +checking for document class t a r t i c l e [ t a r t i c l e , p l e x t . s ty ] . . . no
596 +checking for document class tbook [ tbook , p l e x t . s ty ] . . . no
597 +checking for document class t r e p o r t [ t r epor t , p l e x t . s ty ] . . . no
598 +checking for document class tu f t e −book [ tu f t e −book , b ibentry . sty , changepage . s ty
599 +checking for document class tu f t e −handout [ tu f t e −handout , b ibentry . sty , changepa
600 +checking for package noweb [ noweb ] . . . no
601 +checking for package enumitem [ enumitem ] . . . yes
602 +checking for package endnotes [ endnotes ] . . . yes
603 +checking for package covington [ covington ] . . . no
604 +checking for package fancyhdr [ fancyhdr ] . . . yes
605 +checking for package endnotes [ endnotes ] . . . yes
606 +checking for package b r a i l l e [ b r a i l l e ] . . . yes
607 +checking for package natbib [ natbib ] . . . yes
608 +checking for package a p a c i t e [ a p a c i t e ] . . . yes
609 +checking for package fancyvrb [ fancyvrb ] . . . yes
610 +I n s p e c t i o n done .
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611 +Read the f i l e doc/LaTeXConfig . lyx for more in fo rmat ion .
612 LyX : Done !
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